
 

Welcome   
Welcome to the Onslow County GIS/Mapping System (GoMaps) help pages. 
 The help pages are broken down into sections based on the interface.  To see 
how the interface is broken into sections go to Overview of the Interface.  There 
are help topics for each feature of the GIS/Mapping System.   
 
Take a few moments to expand the  book tabs in the table of contents for the 
Help Pages.  This will show you all of the topics found within them.  There is also 
a glossary and search functions available by clicking on the tabs found above the 
contents listed on the left side of the page: 
 

 
 
 
On the map screen, when you hover your mouse pointer over tools, text, and 
links you will see tips about what they do and how to use them.   
 
Example of tool tips for Identify Layer: 
 

 
 
Example of tool tips for Map Layers: 
 

 
 
 
Click here to download the help in pdf format
 
 

New Users 
The Onslow County GIS/Mapping System is designed so that citizens and county 
employees may easily access geographical information about Onslow County. 
 You can view information about the physical geography such as streams, 
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wetlands and soil types.  There are also many layers of information about human 
geography such as land parcels, city boundaries, streets, zoning, fire districts 
and election districts. 
 
Geographic Information Systems (GIS) maintain two kinds of data:  spatial and 
non-spatial.  Spatial data is what you can actually see on the map, things like 
roads and parcel lines.  Non-spatial data is the information about the spatial 
elements you can see on the map.  For example, the parcel lines that define 
someone's property are spatial data.  The owner name, parcel number, address, 
sale price, deed number and tax information are non-spatial data.  The beauty of 
a GIS is that you can see all of this information at the same time in just one 
place.  Gone are the days of having to locate a paper map to view something, 
then going to the file room to find information about it. 
 
The basic element of any Geographic Information System (GIS) is the map layer. 
 A layer represents some type of spatial data like city boundaries or aerial 
photographs.  There is no limit to how many layers that can be in a GIS.  If you 
can draw it on a map, it can be made into a GIS layer.   
 
The most heavily used layer in a public access website like the Onslow County 
GIS/Mapping System is the parcel layer.  Property owners can find their parcel, 
view all of the county's information about it, turn on aerial photographs of it, and 
print their own map and parcel report for it.  You can do all of this from the 
comfort of your own home, twenty four hours a day.  There is no longer a need to 
go to the Land Records office or the Tax Assessor's office simply to find this 
information.   
 
Since all of the information in the Onslow County GIS/Mapping System is public 
information, you are not limited to finding information about your own property. 
 You can pull up information about any parcel in the entire county.  You can see 
what someone paid for that big new house on Queens Creek or find out who 
owns that new store around the corner.  Those interested in real estate can find 
all the parcels in a certain acreage or price range.   
 

Frequently Asked Questions 
How do I find my parcel? 

The two fastest ways to find a land parcel is to use the Quick Search text box or 
the Address/Name/Parcel Search menu.  These are best if you already know the 
owner name, parcel number or address.  You may also use the Zoom In and 

Pan tools to navigate the map to a desired location, then identify a parcel by 
activating the Identify tool then clicking on the parcel.   
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For further instructions about Quick Search and Address/Name/Parcel Search, 
please click on the links below or select them from the table of contents. 
 
 
 
 

How do I turn on the Aerial Photos? 

Go to the Layer list (it is already up when you first go to the site).  Click on Aerials 
to expand that category and show the options within: 
 

 
 
Click on the checkbox next to the layer you wish to turn on.  The map will refresh 
and the aerial photos will be visible.   
 
*** Aerial photos are not always on because they cause the system to move a 
little slower.  They require large amounts of data transmission. *** 
 
 

How do I print a map? 

Click on the Tools link in the Menu Bar.  This will bring up the tools menu: 
 

3 



Onslow County GoMaps Help Guide 

 
 
Click on  Print PDF or Download Map Image.  With either of these options, 
the map you print will be at the same scale you see on the screen.  The PDF has 
options about the map title, size and orientation.  Download Map Image produces 
an image that is more suitable for inserting into other documents or 
presentations. 
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Solutions for Browser/Network 
Inconsistencies 
Disable Pop-Up Blockers 
In order for GoMaps to function properly, you need to disable Pop-Up Blocker on 
your browser.  While you can turn off Pop-Up Blocker, this is not recommended. 
 It is better to disable Pop-Up Blocker for the website.   
 
Go to Tools/Pop-Up Blocker/Pop-Up Blocker Settings: 
 

 
 
The following window opens: 
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Copy the website address from the browser's address bar (Highlight/Right-
click/Copy): 
 

 
 
Paste it (Right-click/Paste) into the text box for "Address of Web site to allow": 
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Click the "Add" button.  You will see the address added to the list of allowed 
sites: 
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Click the "Close" button.  Now, whenever you visit the GoMaps website on  this 
computer the Pop-Up Blocker will be disabled. 

Internet Explorer 7 Users Make GoMaps a 
"Trusted Site" 
If you use Internet Explorer 7 as your browser, you need to make GoMaps a 
"Trusted Site" for the Latitude/Longitude function to work properly.   
 
Go to Tools/Internet Options: 
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Click the "Security" tab, then click on "Trusted sites": 
 

 
 
Click the "Sites..." button, then enter the site address into the text box 
(copy/paste or type).  If you have "Require server verification (https:) for all sites 
in this zone" checked, you must add an s to the http: in the address, making it 
https: 
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Click the "Add" button.  You will see the site added to the list of trusted web sites: 
 

 
 
Click the "OK" button to close the "Trusted sites" window.  Then, hit the "OK" 
button again to close the "Internet Options" window and you're done. 
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Internet Security 
Some internet security programs such as Norton Internet Security and McAfee 
Security Center may have an adverse effect on the functionality of GoMaps.  By 
simply altering a few settings in the program's configuration, potential issues can 
be averted. 
 
Norton Internet Security Settings 
 
Norton Internet Security, Privacy control, Configure: 
 

 
 
Click on Advanced: 
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Add Site : gisweb .  Then highlight gisweb in the list, and click on the user 
settings tab. 
Uncheck Use Ad Blocking settings.  Click OK. 
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McAfee Security Center  Settings 
 
The Administrator can allow all users to view specific web sites. This overrides 
Privacy Service's default settings and web sites added to the Blocked list. 
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1.  Click Options, and then select Allow List. 
 
2.  In the http:// field, enter the URL of the web site that you want to allow, and 
     then click Add. The web site appears in the Allowed Web Sites list. 
 
 
*If you continue to have any problems with your internet security program 
or with GoMaps, please contact your system administrator or ROK 
Technologies. 

Manage Add-ons 
Users may be prompted to download Add-ons while using the GoMaps website. 
 An Add-on is an accessory software program that extends the capabilities of an 
existing application. They are also often called a plug-in or extension. 
 Essentially, in terms of GoMaps, add-ons help ensure that the site works 
properly. 
 
Add-ons that users are likely to be prompted to download are: 
 

• Any "ActiveX Controls" 
• In particular, PeerDraw Class ActiveX control and the Adobe 

Acrobat Control are essential for the site to function correctly. 
 
If you are prompted to download any "ActiveX Controls", you need to accept 
them. 
 
By simply following the download instructions, the add-ons will be added to your 
browser's current add-ons.  In some cases you may need to restart your browser 
for the add-ons to take effect. 
 
If you already have the appropriate add-on, but it is currently disabled or needs to 
be updated (you should be prompted with a message telling you so) it is easy to 
do: 
 

Go to Tools/Manage Add-ons: 
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This window will appear: 
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You may also view the list of Add-ons that have been used by selecting that 
option from the drop down menu: 
 

 
 

Once you have located the Add-on you want to enable or update, highlight 
it by clicking on it, then take the appropriate actions by selecting "Enable" 
or clicking the "Update ActiveX" button at the bottom of the menu: 
 

 
 
After enabling or updating, you will generally be prompted with a message 
similar to this one: 
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Mac (Safari) Users 
GoMaps does not currently support the Safari browser platform.  It is 
recommended that you use  Mozilla Firefox as your browser while you use the 
GoMaps website.   
 
You could use Microsoft's Internet Explorer, but it has problems with ActiveX 
controls that may render some functions of GoMaps unusable.  In 2003, 
Microsoft announced that it was ceasing further development of Internet Explorer 
for Mac. The browser was not included in default installation of Mac OS X v10.4 
"Tiger" which was released in 2005.  Microsoft discontinued support for the 
product on December 31, 2005 and removed the application from their Macintosh 
downloads site on January 31, 2006. Microsoft recommends "that Macintosh 
users migrate to more recent web browsing technologies such as Apple's Safari." 
  
 
To download a free version of Mozilla Firefox go to:  http://www.mozilla.com/en-
US/firefox/all.html
 
 
To download a free version of Internet Explorer for Mac go to: 
 http://www.download.com/Internet-Explorer/3000-2143_4-10209078.html

Display Latitude and Longitude 
In order to see the latitude and longitude coordinates on your browser's status 
bar (displayed below the map), you may need to change a few settings on your 
browser.  The instructions below detail how to make the necessary setting 
changes for Internet Explorer and Firefox.   
 
1.  Internet Explorer 
 
Go to Tools > Internet Options: 
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Open the "Security" tab, then click the "Custom level..." button: 
 

 
 
Scroll down to "Allow status bar updates via script" and choose enable: 
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Click "OK" button to close window and then "OK" again to close the Internet 
Options window. 
 
You will  need to refresh your screen or restart Internet Explorer for the changes 
to take effect. 
 
 
 
2.  Firefox 
 
Go to Tools > Options... 
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Click the "Content" tab, check Enable JavaScript box, then hit the "Advanced..." 
button: 
 

 
 
Check on "Change status bar text": 
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Click "OK" and then "OK" again on the Options menu. 
 
You will  need to refresh your screen or restart Firefox for the changes to take 
effect. 
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Map Tips 
Map tips provide information about a map feature when you hover over the 
feature with the mouse pointer.  Map tips work only in the Active/Identify Layer 
that has (Map Tips Available) next to the layer name.  To turn on Map Tips,  you 
simply check the box found under Active/Identify Layer. 
 

 
 
 
This is an example of Map Tips  in the parcel layer: 
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Tool Bar 
Zoom in 
Click this icon to make it the active tool.  Then click on the map or drag a box 
around the area you would like to zoom to. 

Zoom out 
Click this icon to make it the active tool.  Then click on the map in the area you 
would like to zoom out from. 

Move the Map by Dragging Mouse (Pan) 
Click this icon to make it the active tool.  Click and hold on the map and drag in 
the direction you would like the map to move. 

Zoom to the Full Extent of the Map 
Click this icon to zoom the full extent of the map. 

Go Back to the Previous Map 
Click this icon to return to the previous extent of the map. 

Query Builder 
This tool allows you to perform single or multiple queries within a data feature 
layer.   
 
First, use the 'Select Layer' drop-down menu to choose the layer to search in 
(parcels, streets, zoning districts, etc).   
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Second, navigate the drop-down menu to select what field to query (these vary 
due to what layer is selected). 
 

 
 
 
Third, pick an appropriate boolean operator (=, >, in, etc) with the adjacent drop-
down menu. 
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Fourth, choose a value from the last drop-down menu (these vary due to what 
field is chosen).   
 

 
 
Finally, click the 'Add to Query' button.  You will see your new query under the 
SQL Statement heading.  At this point you may click the 'Send the Query' button 
(for a single query) or you may add additional queries to your SQL Statement. 
 When using multiple queries in your SQL Statement, you will be prompted with a 
boolean operator choice (and/or) to help direct your search. 

Select Features by Dragging a Box 
Click this icon to make it the active tool.  Choose a layer from the Active/Identify 
Layer pull down menu.   
 

 
 
Click and drag a box around the features you would like to Select.  The features 
will be highlighted and the results will be displayed at the bottom of the map. 
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Identify Map Features 
Click this icon to make it the active tool.  Choose a layer from the Active/Identify 
Layer pull down menu.  You may only identify features within the active map 
layer. 
 

  
 
Then click on the feature you would like to identify.  The feature will be 
highlighted and the results will be displayed at the bottom of the map. 
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Select/Deselect Features by Clicking a Point 
Click this icon to make it the active tool.  Choose a layer from the Identify Layer 
pull down menu.   
 

 
 
Then click on the feature you would like to Select or Deselect.  The results will be 
displayed at the bottom of the map. 

Clear Selected Features 
Click this icon to clear selections or mark ups on the map. 

Toggle Overview Map On/Off 
This tool allows the user to show or hide the county map found in the upper left 
corner of the screen that highlights the zoomed area. 
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Create an Adobe PDF File 
This tool allows you to customize and print your map.   
 
You may use the default map title or alter it by clicking in the Map Title box. 
 Page orientation and page size can be selected through the drop-down menus. 
 

 
 
Click on the 'Make My PDF' button.  A message will appear which prompts you to 
click on Download.  This command will open a full-page view of your printable 
map.  You may find it helpful to hold the 'CTRL' key when clicking Download (this 
will bypass any popup blockers).  You may now print and/or save the map you 
have created. 
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*If you want to print the pdf, you must do so with the print command found 
under the 'File' menu in Adobe Acrobat Reader (the program that allows 
you read pdf files). 

 
If you do not have Adobe Acrobat Reader or if you need an updated 
version, you may download one for free at 
http://www.adobe.com/products/acrobat/readstep2.html
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Menu Bar 
Map Layers 
Layers are the visual representation of geographic data in the GoMaps 
environment.  The capability to combine many layers and make a customized in 
map is one of the many benefits of a Geographic Information System (GIS) such 
as GoMaps.  Please take some time to see what layers are available to view and 
interact with in your system.  Expand the category tabs (all are expanded in the 
illustration below) and experiment by turning on different layers. 
 
When the checkbox is checked, the map will automatically 
refresh when layers are checked on and off.  If you wish to add or remove 
several layers at once, you can turn auto-refresh off, make your layer selections, 
then click the 'Refresh Map' button. 
 
Checking the boxes in the layer menu will add layers to the map.  Layers added 
in this manner are for viewing only.  In order to manipulate or query a layer it 
must be made active by selecting it from the 'Active/Identify Layer' drop-down 
menu found next to the tool bar: 
 

 
 
* Some layers are scale dependent, meaning that they will only be able to be 
turned on when zoomed in past a specific scale (Parcels and Soil Types are 
examples of such layers).   If you try to turn on a layer from the layer list and find 
a "grayed-out" checkbox, you need to zoom in closer to be able to turn on and 
view the layer. 
 
Clicking on 'Map Layers' displays the layers available in the system: 
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Results 
Clicking on 'Results' displays or hides the results window at the bottom of the 
page.  A new results window is created each time a new query is made or when 
the identify tool is used to click on an object in the active/identify layer. 

Links 
Hover your mouse pointer over Links to view the available sites: 
 

 
 
Please take a few minutes to explore these sites that are relevant companions  to 
your GoMaps system. 

Address/Name/Parcel Search - 
Reports/Labels/Deeds 
Introduction 

The Address/Name/Parcel Search feature possesses great functionality.  It 
allows you to search for individual parcels or groups of parcels within specified 
ranges.  The results of your search may be viewed and manipulated in a variety 
of ways.  You may accomplish a range of tasks using this GoMaps feature such 
as: 
 

• View parcel record information in table/list  format 
• Zoom to the selected parcel to view or print a map 
• Create user-specified buffers around a parcel 
• Export the parcel record information to an Excel spreadsheet 
• View and print Parcel and Map Image Reports 
• View or print Property Report Cards 
• Find information about adjoining parcels with just one click 
• Locate properties by year built, city limits, township or neighborhood 

code 
• Search for properties by ranges in acreage, sales price and deed 

date 
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Parcel Query Menu 

Clicking on 'Address/Name Parcel Search' displays this menu: 
 

 

 

 
 
 
Entering values or ranges for any or all of the fields and clicking the 'Search!' 
button will execute a query for parcels within those parameters.  The results of 
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the query will be shown in the results window at the bottom of the page.  If the 
query is valid the results will be displayed in the results window at the bottom of 
the screen.  
 
Example 1:  Search By Name 
 
The following is an example of a parcel query and results for John Smith.  Enter 
the name in the box and click the 'Search!' button. 
 

 
 
This results box will be displayed at the bottom of the page: 
 

 
Within the results window, you may simply scroll and view the record information 
or use any of the GoMaps functions described in the Address/Name/Parcel 
Search portion of the Help Menu. 
 
Example 2:  Search By Attribute Range (Acreage) 
 
The following is an example for a search by acreage range.  You will find all of 
the parcels within the range of 1000-1500 acres.  Pull up the Parcel Query menu, 
enter the appropriate range, then click the 'Search!' button. 
 

 
 
The following results window will be shown: 
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Within the results window, you may simply scroll and view the record information 
or use any of the GoMaps functions described in the Address/Name/Parcel 
Search portion of the Help Menu. 
 
 
Zoom to Selected Parcel 

You may zoom in to any selected parcel in the results window by either clicking 
the  zoom icon or by clicking on  
Zoom in.  If desired, the new map view may be saved or printed. 
 
 
 
 

Buffer Features 

Clicking on the buffer icon in the results window displays the following menu: 
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Enter the distance (in feet) that you wish the buffer to be and click the 'Create 
Buffer' button. 
 
 
Example 1:  Create Buffer for a Parcel 
 
Here is an example of a 100 foot buffer created for John C. Smith's land parcel: 
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Example 2:  Buffer Intersection with Feature Layer 
 
To see how/if a buffer intersects another feature layer you may choose a layer 
from the drop-down menu in addition to entering in a buffer distance.  The 
following example shows how John C. Smith's land parcel with a 100 foot buffer 
intersects the Zoning Districts layer.   
 
Choose the settings in the menu: 
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Click the 'Create Buffer' button to create the new map view: 
 

 
 

Create Excel Spreadsheet 
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After selecting the record(s) you wish to convert to Excel, click on the  Excel 
icon.   
 
The following menu will appear: 
 

 
 
Choose to open or save the new spreadsheet. 
 
This is an example of a spreadsheet created using the tool: 
 

 

Create Mailing Labels 

Clicking on the  Create Mailing Labels icon will display the following menu: 
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Navigate the drop-down menu to choose the desired Avery mailing label style: 
 

 
 
Clicking the 'Submit' button will display the following: 
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Clicking on Download Labels brings up this menu: 
 

 
 
Make your selection to open or save the label file. 
 
 
Example of the Word label document: 
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Reports 

The following types of reports are available to view and print for Onslow County 
properties: 
 

• Property Report Card 
• Map Image 
• Parcel Data 

 
 
The Report link is found in the results window: 
 

 
 
Clicking on the Report link in the results window will take you to a new page 
that shows the menu below.  Use the checkboxes to select as many reports as 
you wish.  You may also check the box to create the reports in PDF format.  If 
you want to print the PDF reports, you must do so by selecting Print under the 
'File' menu after opening the PDF file. 
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Clicking the 'Continue >>>' button displays the report(s) selected: 
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Find Adjoiners 

Clicking on the Find Adjoiners link in the results window will display a list of 
parcels that join the selected parcel of land.  
 
If you zoom in to the selected parcel and then click Find Adjoiners a new 
map will be created.  Here is an example of a map of adjoiners for a land parcel: 
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Sort Table Columns 

When viewing a lengthy list of records in the results window you may find it 
useful to sort the records by Name, PID, PIN, etc.  By simply clicking on the 
column heading you may toggle between an A-Z (lowest to highest) list and a Z-
A (highest to lowest) list. 
 
If you do choose to sort in this manner a red arrow appears next to the heading 
to note the orientation: 
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Tools 
Link To This Page 

This tool allows you to make a bookmark/favorite of any map you have created 
using GoMaps.  It saves the layer settings, the map extent, selections and 
results.  With this tool, you can create a catalog of useful maps to suit your own 
personal needs.  You may also use it to simply save your current settings if you 
need to leave the computer. 
 
When you have a map configured and want to save a bookmark/favorite of it, 
open the tools menu and click on  Link To This Page. 
 
The following message will appear: 
 

 
 
Click "OK" and wait for the page to refresh.  When it does you may add this as a 
bookmark/favorite.   
 
To add a favorite in Internet Explorer, click on "Favorites" and then on "Add to 
Favorites":  
 

 
 
You will see this window where you can name the favorite whatever you wish. 
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You may find it helpful to create new folders to keep your saved maps organized. 
 To do so in Internet Explorer, click on "Favorites" and then on "Organize 
Favorites": 
 

 
 
This window contains options for customizing and organizing your favorites: 
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Create an Adobe PDF File 

This tool allows you to customize and print your map.   
 
You may use the default map title or alter it by clicking in the Map Title box. 
 Page orientation and page size can be selected through the drop-down menus. 
 

 
 
Click on the 'Make My PDF' button.  A message will appear which prompts you to 
click on Download.  This command will open a full-page view of your printable 
map.  You may find it helpful to hold the 'CTRL' key when clicking Download (this 
will bypass any popup blockers).  You may now print and/or save the map you 
have created. 
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*If you want to print the pdf, you must do so with the print command found 
under the 'File' menu in Adobe Acrobat Reader (the program that allows 
you read pdf files). 

 
If you do not have Adobe Acrobat Reader or if you need an updated 
version, you may download one for free at 
http://www.adobe.com/products/acrobat/readstep2.html

Create Custom Print Map 
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This tool allows you to alter the map title by clicking in the 'Map Title' box.  You 
may also select border thickness and color by navigating the appropriate drop-
down menus.  After making your changes, click the 'Submit' button to view your 
new map.  
 
 
 

 
 
 
Example of custom print map: 
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Download Map Image 

This tool creates a zipped jpeg image of the current map you can see on your 
screen.  Click on  Download Map Image and the following window will open: 
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You may save it directly to your computer or other media device.  You  can also 
open it up and view it before saving.  Since it is a zipped file, it is already in a 
format suitable for emailing to others.  

 Download Map Data (Shapefiles) 

This tool allows you to download shapefiles that can be loaded into another GIS 
program such as ArcGIS.  The tool will only download the layers that are turned 
on, so make sure the ones you want to save are on.  Clicking on  Download 
Map Data (shapefiles) brings up this window: 
 

 
 
Most users will want to save the zipped files to their hard drive.  Click save and 
this window will appear: 
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You may rename the file (must keep the .zip extension) and save it in the 
location of your choice.  If you save it to your desktop, the icon for the saved file 
will look something like this: 
 

 
 
If you open up the zipped file you will see its contents: 
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It is best to extract the zipped files to a new folder (to help keep you organized) 
 on your local hard drive or a network hard drive.  From there, you can open up a 
new or existing mxd file in ArcMap and load in the desired shapefiles. 

Query Builder 

This tool allows you to perform single or multiple queries within a data feature 
layer.   
 
First, use the 'Select Layer' drop-down menu to choose the layer to search in 
(parcels, streets, zoning districts, etc).   
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Second, navigate the drop-down menu to select what field to query (these vary 
due to what layer is selected). 
 

 
 
 
Third, pick an appropriate boolean operator (=, >, in, etc) with the adjacent drop-
down menu. 
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Fourth, choose a value from the last drop-down menu (these vary due to what 
field is chosen).   
 

 
 
Finally, click the 'Add to Query' button.  You will see your new query under the 
SQL Statement heading.  At this point you may click the 'Send the Query' button 
(for a single query) or you may add additional queries to your SQL Statement. 
 When using multiple queries in your SQL Statement, you will be prompted with a 
boolean operator choice (and/or) to help direct your search. 

Radius/Buffer Query 

This tool allows you to search for map features within a specified distance from a 
chosen center point. 
 
First, select a point on the map as your center point (intersection, parcel, 
municipality, etc).  Use the zoom in/out tools to find an appropriate view. 
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Second, you will be prompted with a 'Select Layer' drop-down menu.  Please 
select accordingly. 
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Third, choose the search distance (radius) you wish to investigate from your 
center point.  This value may be selected from the drop-down menu or entered 
manually. 
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Finally, click the 'Go!' button. 
 
You will see your results both graphically (shaded circle) and in a list/table at the 
bottom of your window.  Use the zoom/pan tools to navigate your map as 
needed. 
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 Create Labels 

This tool allows you to add custom labels to map features.  You may only label 
features one at a time with this tool.  You can only label by fields that exist 
within the chosen layer.  You do have control over where the labels are placed 
(wherever you click on the map) and what color, size, font and callout box you 
wish. 
 
Click on  Create Labels and the following menu will appear: 
 

 
 
 
After choosing a layer to label in another menu opens giving you field choices for 
that layer: 

66 



Menu Bar 

 
After choosing the field to label, you can make choices about the appearance of 
the labels: 
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Click on the map where you want the labels to be placed: 
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Menu Bar 

 
You may choose "Click here" when you are finished or "Create More Labels" to 
repeat the process for new layers and/or fields. 
 
You can clear labels by clicking the  Clear Selected Features tool in the 
toolbar. 
 

Geocode 

The geocode tool allows you to find locations for street addresses and locations 
of street intersections on the map.  Geocoding does not always find the 
precise location!  It finds the address by scanning address ranges for streets.  It 

will be close, however, and in some cases, right on the mark.  Click on  
Geocode and this menu will display: 
 
 
 

 
Choose to locate an address or to find a street intersection.  The first example is 
for locating an address, the second for street intersection. 
 
Example 1:  Geocode by address 
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Enter a street (house) number in the first text box.  Begin typing a street name in 
the second text box.  A list of possible matches will appear below: 
 

 
 
Click on the name of the street that best matches the one you are searching for 
an address on.  It will be placed  in the Street Name text box: 
 

 
 
Click the "Submit" button and you will see a list (or just one) of possible matches: 
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The higher the match score, the greater the likelihood of it being the correct 
location.   
 
Click on Zoom To and the map will refresh and zoom to the location marked with 
a pushpin: 
 

 
 
 
 
 
Example 2:  Find Street Intersection 
 
First you enter the primary street: 
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Again, you will see a list of possible street names appear as you type: 
 

 
 
Click on the street that best matches and it will fill in the text box and 
automatically take you to a new menu that has a drop down list of the streets that 
intersect the primary street you have chosen: 
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Choose the desired street from the drop down and click the "Submit" button. 
 This window will appear: 
 

 
 
Click on Zoom To and the map will refresh and zoom to the intersection marked 
with a pushpin: 
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Measure 

This tool allows you to create a line and determine its distance. It is useful for 
calculating distances between map features.  You may create a single two-point 
line or one with multiple segments.   
 
After zooming  to an appropriate map scale, use the pointer to click on a start 
point.  Move the pointer to an end point.  You will see a new line appear on the 
map.  If you are drawing a line with multiple segments simply keep adding new 
endpoints to the existing line.  When finished you have the option of clicking 
'Finish and show distance labels'.  This feature will label the lines you have 
drawn on your map.  You will also see the distance(s) listed in the measure tool 
window. 
 

 
These lines of measurement may be used for reference only or they can be 
added to your map and saved/printed in PDF format. 
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Determine Area 

This tool enables you to calculate the area of a user-defined polygon. 
 
Use the mouse to draw a polygon on your map.  It is useful to practice attaining 
the shape you desire.  You may need to start over several times before achieving 
your goal.  After you are satisfied with your polygon click 'Determine Area'.  You 
will see the shaded polygon on the map and its numerical value listed in both 
square feet and acres in the adjacent window. 
 
 
Example: 
 

 

Identify Multiple Map Features (Drill Down) 

This tool allows the user to click on a point on the map and pull up information 
about multiple layer attributes such as parcels, lot lines, township and city limits.   
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Click on the Tools link to open the tools menu, then click on the  Identify 
Multiple Map Features link: 
 

 
 
 
Click on any point on the map. The Drill Down Identify Results window will 
appear: 
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Glossary 
A 

Address/Name Parcel Search: A GoMaps tool/function that allows the user to 
search for land parcels by name, PID, PIN, deed book, acreage range, 
deed date, building value range, land value range, total value range and 
sale price range. 

Adjoiners: Parcels that are adjacent to a selected parcel of land. 
Attribute: Nonspatial information about a geographic feature in a GIS, usually 

stored in a table and linked to the feature by a unique identifier. For 
example, attributes of a parcel might include name of owner, address, 
acreage and assessed value. 

B 
Boolean Expression: An expression, named for the English mathematician 

George Boole (1815-1864), that results in a true or false (logical) 
condition. For example, in the Boolean expression "HEIGHT > 70 AND 
DIAMETER = 100," all locations where the height is greater than 70 and 
the diameter is equal to 100 would be given a value of 1, or true, and all 
locations where this criteria is not met would be given a value of 0, or 
false. 

Boolean Operator: A logical operator used in the formulation of a Boolean 
expression. Common Boolean operators include AND, which specifies a 
combination of conditions (A and B must be true); OR, which specifies a 
list of alternative conditions (A or B must be true); NOT, which negates a 
condition (A but not B must be true); and XOR (exclusive or), which makes 
conditions mutually exclusive (A or B may be true but not both A and B). 

Boundary: A line separating adjacent political entities, such as countries or 
districts; adjacent tracts of privately-owned land, such as parcels; or 
adjacent geographic zones, such as ecosystems. A boundary is a line that 
may or may not follow physical features, such as rivers, mountains, or 
walls. 

Buffer: 1. A zone around a map feature measured in units of distance or time. A 
buffer is useful for proximity analysis. 2. A polygon enclosing a point, line, 
or polygon at a specified distance. 

Button: A command that executes a function, macro, or custom code when 
clicked. 

C 
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Census Block: The smallest geographic entity for which the U.S. Census 
Bureau tabulates decennial census data. Many blocks correspond to city 
blocks bounded by streets, but blocks in rural areas may include several 
square miles and have some boundaries that are not streets. The Census 
Bureau established blocks covering the entire nation for the first time in 
1990. Previous censuses dating back to 1940 had blocks established only 
for part of the nation. 

Custom Print Map: A printable map that contains user-defined features and 
labels. 

D 
Deed: 1. A document sealed as an instrument of bond, contract, or conveyance, 

especially relating to property. 2. A legal document signed and sealed and 
delivered to effect a transfer of property and to show the legal right to 
possess it. 

Deed Books: The books, files, or record storage of the Public Records in which 
county governments keep the deeds and other real estate-related 
documents that have been filed. 

F 
Feature: A representation of a real-world object on a map. Features may be 

points (cities, schools); lines (roads, rivers, boundaries); and polygons 
(land parcels, counties, lakes, districts). 

Function: An operation. In GIS, functions include data input, editing, and 
management; data query, analysis, and visualization; and output 
operations. 

G 
GIS: Acronym for geographic information system. An integrated collection of 

computer software and data used to view and manage information about 
geographic places, analyze spatial relationships, and model spatial 
processes. A GIS provides a framework for gathering and organizing 
spatial data and related information so that it can be displayed and 
analyzed. GoMaps is a web-based, customized GIS. 

GUI: Acronym for Graphical User Interface. A software display of program 
options that allows a user to choose commands by pointing to icons, 
dialog boxes, and lists of menu items on the screen, typically using a 
mouse. This contrasts with a command line interface in which control is 
accomplished via the exchange of strings of text. 

I 
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Icon: A graphic symbol (usually a simple picture) that denotes a program, tool, 
command, data file or a concept in a graphical user interface. 

Interface: The display window that contains the map and toolbars. 

L 
Land Use: The classification of land according to what activities take place on it 

or how humans occupy it; for example, agricultural, industrial, residential, 
urban, rural, or commercial. 

Layer: 1. The visual representation of a geographic dataset in any digital map 
environment. On a road map, for example, roads, national parks, political 
boundaries, and rivers might be considered different layers. 2. In GoMaps, 
a reference to a data source, such as a parcels, imagery, demographics 
and political features that defines how the data should be symbolized on a 
map. 

Link: In a hyperlinked document, a graphic or piece of text that, when selected 
by a user, causes the display to move to another document or to another 
location within the same document. Helpful links in GoMaps are located 
above the menu bar in the interface. 

M 
Map: 1. A graphic representation of the spatial relationships of entities within an 

area. 2. Any graphical representation of geographic or spatial information. 
3. The document used in GoMaps to display and work with geographic 
data. In GoMaps, a map contains one or more layers of geographic data 
and various supporting map elements, such as legends and scale bars. 

Map Extent: The limit of the geographic area shown on a map, usually defined 
by a rectangle. In a dynamic map display like GoMaps, the map extent 
can be changed by zooming and panning. 

Measurement: An observed numerical value that is an appraisal of size, extent, 
or amount according to a set criteria. 

Menu: A list of available commands or operations displayed on a computer 
screen from which a user can make a selection. 

Menu Bar: The area of the interface that allows interaction with other 
tools/functions of GoMaps. 

O 
Overview Map: A generalized, smaller-scale map that shows the limits of 

another map's extent along with its surrounding area. Also called an index 
map. 
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P 
Pan: To shift a map image relative to the display window without changing the 

viewing scale. 
Parcel: A piece or unit of land, defined by a series of measured straight or 

curved lines that connect to form a polygon. 
Parcel Type: A classification for parcels, used to provide additional information 

about them. Standard parcels, blocks, and easements are all examples of 
parcel types. 

PDF: Acronym for Portable Document Format. A proprietary file format from 
Adobe that creates lightweight text-based, formatted files for distribution to 
a variety of operating systems. 

Polygon: On a map, a closed shape defined by a connected sequence of x,y 
coordinate pairs, where the first and last coordinate pair are the same and 
all other pairs are unique. Land parcels are represented by polygons in a 
GIS. 

PRC: An acronym for Property Record Card. A document that contains 
information about a parcel/property necessary for tax assessment 
purposes. A printable copy of a PRC is available through GoMaps. 

Q 
Query: A request to select features or records from a database. A query is often 

written as a statement or logical expression. 
Query Builder: A tool/function of GoMaps that allows the user to customize a 

search and create specific maps. 

R 
Radius: The distance from the center to a point on the outer edge of a circle, 

circular curve, or sphere. 
Radius/Buffer Query: A GoMaps tool/function that allows the user to search for 

map features within a specified distance from a chosen center point. 
Results: The outcome of a search/query. In GoMaps, results are displayed 

cartographically and in table form. 

S 
Scale: The ratio or relationship between a distance or area on a map and the 

corresponding distance or area on the ground, commonly expressed as a 
fraction or ratio. A map scale of 1/100,000 or 1:100,000 means that one 
unit of measure on the map equals 100,000 of the same unit on the earth. 
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Spreadsheet: Table of data arranged in columns and rows often used in 
business and financial applications. Spreadsheet software programs are 
widely used computer applications that allow the user to organize large 
amounts of data. 

T 
Table: A set of data elements arranged in rows and columns. Each row 

represents a single record. Each column represents a field of the record. 
Rows and columns intersect to form cells, which contain a specific value 
for one field in a record. 

Tax Parcel Report: A printable document that contains a map of a land parcel 
and its related information pertaining to tax assessment. 

Toggle: To alternate between two or more electronic, mechanical, or computer-
related options, usually by the operation of a single switch or keystroke: 
toggled back and forth between two windows on the screen. 

Tool: A command that requires interaction with the GUI before an action is 
performed. For example, a zoom tool requires a user to use the mouse to 
click on or draw a box over a digital map before the tool will cause the 
map to be redrawn at a larger scale. 

Toolbar: A graphical user interface (GUI) with buttons that allow users to 
execute software commands. 

Z 
Zoom: To display a larger or smaller region of an on-screen map or image. 
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